Product Name
Beta2 CD-ROM
dated June 18, 1999
Sample Testing Report
Folio/Acrobat product
July 1, 1999

Summary:

The product functioned well for the most part, however there were also some broken
links and some graphics problems. There were problems with the installation of Adobe

Acrobat on some systems.
Testing Personnel:
Bryan Ekelund, Marianne Pandarakalam, John Rudzianski, and Reed Payne

SAMPLE REPORT: The product name, publisher name and other
sensitive information have been removed and replaced with the words
"PRODUCT NAME", PUBLISHER, or ***** gsappropriate. Other
information may have been removed to protect client confidentiality.

Hudson Software Corporation Test Report 914-773-0400 Page 1



Har dwar e Used:

The following machines were used to test the software:

Windows
Make/M odel Processor | Clock Speed RAM Windows Version

Midwest Micro Pentium |1 300 MHz 64 Mb Windows NT 4.0
Midwest Micro Pentium MM X 200 MHz 32 Mb Windows NT 4.0
UMAX AMD K6-2 350 MHz 64 Mb Windows 98
Midwest Micro Pentium 133 MHz 32 Mb Windows 98
Swan Pentium 133 MHz 32 Mb Windows 98
Hewlett Packard | Celeron 333 MHz 32 Mb Windows 95
Midwest Micro Pentium 11 233 MHz 64 Mb Windows 95
Quantex Pentium MM X 200 MHz 32 Mb Windows 95
HP Vectra Pentium 100 MHz 32 Mb Windows 95
Clone Pentium 90 MHz 16 Mb Windows 3.11
IBM Aptiva 486DX?2 66 MHz 16 Mb Windows 3.11

Windows Network

For network testing in Windows we have a both a Novell NetWare 3.12 network and a
Windows NT 4.0 network. Much of the NetWare 3.12 testing was done using a JES CD-
ROM tower with an Axis server. On the Windows NT network we briefly tested the
software with the CD-ROM in the internal CD-ROM drive of the file server.

M acintosh
Make/M odel Pr ocessor Clock Speed RAM OSVersion
G3 Minitower PowerPC 750 300 MHz 64 Mb System 8.5
iMac PowerPC 750 233 MHz 32Mb System 8.5
Performa 6400 PowerPC 603e 200 MHz 32 Mb System 8.1
Quadra 68040 66 MHz 16 Mb System 7.5.3

All Macintosh testing was done in standal one configurations.

Procedures:

We have tried to looked at as much of the content of the product and check as large a
sampling of the links as possible, but given the time allotted we could not look at all of
the content and check every link. We have focused more on the functionality of the
product.
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Installation:

Windows

@

2

3

The installation creates a program group with the product abbreviation. It might be
clearer if labeled ****; the same might be true with respect to the screens
presenting the product name during installation. Thereis plenty of space on the
program start-up icons.

We found that the Adobe Acrobat 4.0 installation did not detect version 2.1 of
Acrobat Reader. Once version 4.0 was installed on a system where version 2.1 was
already installed, version 2.1 was brought up as the default and there were problems
viewing the images.

On one occasion, the Adobe Installer did not 'finish." One dialog box would ask you
if you wanted to restart the computer. When trying to restart, it would not continue.
The only way we were able to move on was to End Task from Task Manager.

Documentation:

@

There is no readme file. A readme file detailing the minimum system requirements
should be included, especialy in light of the problem encountered with the
resolution settings (which are covered in the Operational Problems in Windows
Only: section of this report).

Directions on the best use of Acrobat Reader should also be included. Closing
Acrobat Reader meant that it be reloaded each time a new photo is viewed. On the
other hand, failure to close the photograph depletes available resources and led to a
system crash. Closing the photo and minimizing Acrobat Reader seems to work
best.

Operational Problems Common to Windows and M acintosh:

N

In the **** gection, the answer to question 454 had two broken links as seen in the
following screen captures:

Folio Views Folio Views [ <]
& The Destination named 'P438' could not be found. & The Destination named 'P513" could not be found.

[360.5) [360.5]
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(2) Ineachinfobase, all thumbnails were being printed twice (see attached print out).
We replicated this with every thumbnail we printed from within Folio on any
system and printer.

(3) Thefollowing broken links were noted in the Getting Started section:

Record 182: Searching the subset of atitle, Show Check Boxes.
Record 228: Hit List Properties, Determining Relevance.

(4) Inthe***** jnfobase, hits from searches using the Headword field of the Index
Query Template are not highlighted.

(5) After following the linksto ***** in the answer sections ***** Review, clicking
the Back button did not return us to the question at which we were originally
looking at (see the following screen capture). We were returned to a blank page at
the beginning of the book, amost as if you never opened the book. To get back to
the question, we had to click Back twice. The bookmark tree was collapsed.
Clicking on the Forward button when at the question lead us to the answer again.

(6) In Chapter 48 of ****  the bookmarks at the beginning of the chapter point to the
chapter outline instead of the text, as seen in the following screen
capture.(SCREEN CAPTURE REMOVED). Isthis correct? None of the other
chapters had bookmarks that pointed to the chapter outline.

(7) The***** gubheading in the Chapter 79 bookmarks of ***** jsmissing the special
character y in the beginning of this bookmark as seen in the following screen
capture: (SCREEN CAPTURE REMOVED).

(8) Scrolling is often slow or impossible when images are loading. 1t seemed like all
the graphics on a page must load before links could be accessed. This occurred in
Macintosh, but we also saw it happen on a Windows 3.x system that we put the
software on very briefly.

Operational Problemsin Windows Only:
(1) Withthedisplay set to 640 x 480, the text is chopped off the right side of the

screen. The text can not be viewed because there is no horizontal side bar. The
horizontal scroll bar was on the Mac.
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(2) When using the Help link from the Personalization Query Template, we received
the error seen in the following screen capture.

—

Folio Help

Unable to find the requested help topic.
[Group CL Personalization Query Template]

to help you
duct.

(3) When attempting to view images, we found that if the CleanSweep installation
monitor was active it would open as if it was trying to monitor an installation of

Adobe. Disabling the CleanSweep utility allowed normal viewing. This replicated
on al Windows 9x systems.

(4) We encountered the error depicted by the following screen capture when we
attempted to use the Find Infobase option on the File menu. Also, the Explore
Infobase option on the File menu did not work at all.

Folio Views

Q lInable to find infobases: MiaFind. exe was not faund.

(5) On one Windows 98 system, we failed to get the graphic for the first page of
Chapter 6 as well as Chapters 4 and 5 as seen in the following screen capture.
During our screen capture procedures, the graphic displayed. A similar problem
was noted on another Windows 98 system in the Answers section of the review
program.

Hudson Software Corporation Test Report 914-773-0400 Page 5



(6)

()

(8)

©)

(10)

(11)

On one of our Windows NT systems, the First Time User link to the help filein all
of the infobases was broken and would generate the error message shown in the
following screen capture:

Folio Yiews

Unable to open the infobase.
The master infobage for this shadow, 'Folichelp.nfo’ could not be found or was replaced by
another infobase with the same name.

(3652.1]

This replicated on two Windows 3.11 systems, but not on any other 32-bit systems,
including another Windows NT system. We reinstalled on the first NT system and
the error still occurred.

There is no clear way to exit the tutorial once it is started. It is possible to close it
by pressing Escape, however.

In one instance the figures would not link with Acrobat Reader 4.0. In this case
Acrobat Reader 3.0 was on the system, and we were prompted to exit the
installation of Adobe Acrobat Reader 4.0 to uninstall version 3.0. We did this and
then installed version 4.0 from the CD using the Acrobat installer. When we tried
to view afigure, the product could not find the Acrobat Reader. We were prompted
to indicate where to find Acrobat Reader. After navigating to the Acrobat program
we were able to view all figures.

One way to avoid this error might be to make sure that Acrobat is not already
installed on the system when initialy installing the ***** product.

The tutorial 'control panel’ did not function properly in Windows 98 and Windows
NT. The buttons and the audio side bar were there but did not work correctly. The
audio control worked in Windows 95, but the other buttons did not.

The Tutorial did not run correctly on one of our Windows NT systems. We tried
using it through the link on the Start menu and also from the Title page link. Only
the introduction and ending screens were available. Advancing to the last screen
gave us an option of either reviewing or exiting. Clicking on review brought us
back to the opening screen once again. This did not replicate on any other systems.

In Windows 3.11, the Tutorial would not close when we clicked on Exit at the end
of the Tutorial. The Review Tutoria button did work however, to bring us back to
the beginning of the Tutorial.
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(12) Although we did not experience any crashes in Windows 3.11, the software uses a

large percentage of the system resources. On a system with 32 MB of RAM the
system had 73% resources before running Product Name. After opening two
infobases in GI Comp, system resources went down to 50% and after we opened a
figure with Acrobat resources went down to 40%. With all four major infobases
open and one figure resources went down to 32%. Fortunately we did not crash the
system, but such low resources will typically cause a crash in Windows 3.x.

Performance on a 90 MHz Windows 3.11 system was a little sluggish but not bad.
Even so the System Requirements for the product should recommend Windows 95
or higher and specify 32 MB of RAM.

Operational Problemsin Macintosh Only:

@

2

3

(4)

We found that several records in the ***** had difficulties with images on the
M acintosh:

Record 21 was missing its image altogether.

Record 371 had an image that was incomplete. There was a (blank) white band
across the image.

We found that graphics take along time to load or sometimes do not load at all on
Macintosh systems. When the graphic did not display, the link was still available.
This was evident because the cursor changed to the Hand icon. This problem
appeared to happen more frequently on the 6400 (an older system) rather than the
newer iMac.

There was an isolated problem on the iMac when using the Go To function
contained in the Search menu. When typing the record number, it did not display in
the text box. Although the numbers did not display, we could still perform the
function. This happened for a while and then stopped happening. We could not
replicate this error on this system or on any other.

The following records had Figure link button graphics that were smaller than others,
as seen in the following screen capture (SCREEN CAPTURE REMOVED):

Gastrointestinal and Liver Disease Records 676, 3593, and 20028
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Q)

We were unable to get the product to run on our Quadra system.

.: ri, Dec 31,1999, 11:52 PM
Atlas of Gaslo Endesoopy ‘ Eon, Oct 12, 1998, Z:33 PM
t—s 1L Loe o L L R L O 0
[” Unable tu_luad the user interface
u resource library:
—_— Quadra Int Drive:Gl
r—rr—a Comp:Plug-ins:vwsENU4m.dll
12K System Error: 0
—
—
s0K 4
—
—
—
o
156K

After we got this error we recalled that we had seen this same error on the ***** product,
which also used Folio 4.2. Thisisaknown problem with Folio 4.2 and non-PowerPC
Macintoshes and the system requirements should specify PowerM acintosh computers.

Content Errors:

@

Figure 1-2 in ***** infobase does not have a caption page.

I nterface and Other |ssues:

N

@)

3

We were redlly confused with respect to the title; is*****" (audio) or ***** (title
on the tutorial). Still adding to the confusion, the title referred to on the
setup/installation screensis ***** and the title displayed in Explorer associated
with the CDROM icon is"***** " All four titles are different.

The Uninstall program group icon is incorrectly labeled as "Uninstall *****" while
the Uninstall program refers to uninstalling "***** (a different name)."

There is an extraneous error. TXT file on the CDROM. s this necessary for the
final product?
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(4) The color scheme did not seem to be correct when set to 256 colors. The detailed
medical photographs displayed better when the video was set to 16-bit colors. Do
you want to add 16-bit color or better to the requirements?

(5) The Help menu shown in the Tutorial has fewer items than the actual Help menu in
the product. The actual product has a"How do I" option and an "Overview" option,
while the Tutorial shows a"Tutoria" option in place of these.

(6) The product allows you to edit the text of the shadow file. |Isthiswhat you want?
We realize this allowance may be to enable changing formats for printing wide
tables.
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